
When you import data into Excel, it 
doesn’t always go as planned. You often 
need to flip-flop, or transpose, your data 
so that the columns become rows and 
the rows become columns. We’ll show 
you how to do it without spending hours 
of valuable time.

You probably use firewalls to protect 
your company’s network, but what 
about individual workstations? We’ll step 
through setting up firewalls to protect 
your Vista workstations from attackers.

Placing new images or text in your 
InDesign document can test anyone’s 
patience. Get the job done faster by 
placing several objects at once in 
InDesign CS3.

Putting your training into practice.
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From the Editor

Buy yourself some time: Switch rows of data 
into columns without retyping

Sometimes a worksheet you’ve already created has the potential to perform a new 
function in a different worksheet, but you need to tweak it — for example, you need 
the new worksheet to be row-oriented rather than column-oriented. You may worry 
that copying and pasting, or retyping, is the only way to make this happen. We’ll show 
you how you can use the TRANSPOSE function to make Excel do double duty — not you.

When TRANSPOSE trumps 
Paste Special
Using TRANSPOSE is not the quickest way to 
transpose data. As we describe in the section 
“Transpose data when you paste it,” you can use 
Excel’s Paste feature to transpose information. 
Both methods have their benefits in certain 
situations. Here are some of the times when 
TRANSPOSE works and pasting falls short: 

•		  You want your transposed data to be 
linked to its non-transposed source. 
This means that if you change the non-
transposed data, the corresponding 
transposed data automatically changes.

•		  You want to transpose data without 
displaying it. This behind-the-scenes 
transposing works well when you only 
need transposed data for a calculation.

Related Courses
•		  Excel 2000, 2002, 2003, 2007 & 2007 New Features

•		  4002 Forecasting and Trend Analysis Using 
Microsoft Office Excel 2003

•		  4003 Summarizing Microsoft Office Excel 2003 
Data to Make Better Business Decisions
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Prepare a TRANSPOSE 
function 
The TRANSPOSE function involves just one 
component: the array, or range of cells you wish 
to transpose. The function’s syntax is as follows:

=TRANSPOSE(array)

Figure A shows a TRANSPOSE function and its 
corresponding array for the formula:
=TRANSPOSE(A2:F6) 

Create employee reports that 
maintain privacy
Our sample file contains a lot of personal 
information that must be kept confidential. In 

Business skills for the new world of work
In business today, productivity is key to your success. Whether that means setting up projects for 
success, forecasting and analyzing trends, or managing critical business information, it is vital that you 
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order to create individual reports for each 
employee that display this information, 
we’ll pull each employee’s information 
into a separate worksheet. We’ll need 
to transpose the row-based data into 
columns so it will easily print on just one 
page. Also, these transposed worksheets 
are easy to update and reuse. 

Set up a TRANSPOSE 
function
We’ll create a personal information 
worksheet for our first employee by 

linking his information from the first 
sheet of the workbook to the second.

To transpose data from rows to 
columns:

1.		  On the All Employees sheet, 
note the data range you’ll need 
for Jacob Stevens’ personal 
information and for the column 
labels. This range, or array, is A1:L2. 
It contains 2 rows and 12 columns.

2.		  Move to the J. Stevens worksheet 
and select 12 rows and 2 columns, 
cells A1:B12.

3.		  Type the formula =TRANSPOSE(‘All 
Employees’!A1:L2). 

Tip: We instructed you to type ‘All 
Employees’! at the beginning of your 
array because your array resides on the 
All Employees worksheet.

4.		  Press [Ctrl][Shift][Enter] to apply 
the formula.

When you click any cell within your 
transposed data, brackets surround the 
formula in the Formula Bar, signaling that 
you have typed an array formula.

Format your results
As you can see, the TRANSPOSE function 
doesn’t retain cell formatting. To 
properly format the cells, we’ll: 

•		  Resize columns and left-align text.

•		  Hide the zero in cell A1.

•		  Format the cell for the employee’s 
hire date.

•		  Format the cell for the employee’s 
gross salary.

Transpose data when you 
paste it
If you want to transpose row-based 
data to columns, or vice versa, 
consider using the easiest method: 
Paste Special. This method works well 
in the following situations:

•		  You want to retain the 
selection’s formatting (shading, 
font, etc.) when you transpose it.

•		  Your selection contains some 
blank cells. (In contrast, using 
TRANSPOSE leaves a zero in any 
blank cells. )

To transpose data from rows to 
columns:

1.		  Select the cells in the row (or 
rows) you wish to transpose.

2.		  Press [Ctrl]C, or select Edit | Copy 
from the menu bar, to copy the 
row(s). (Don’t try to use [Ctrl]X 
or Edit | Cut — it won’t work for 
transposing.)

3.		  Right-click on the first cell of the 
column into which you want 
to paste the data. Select Paste 
Special from the shortcut menu.

4.		  Select the Transpose check box 
in the Paste Special dialog box, 
and click OK.

5.		  If you’d like to delete the row-
based source data, select it and 
press [Delete].

Special considerations
•		  None of the source cells can 

overlap with a destination cell. 

•		  In Excel 2002 and 2003, you 
can transpose data by clicking 
the dropdown arrow on the 
Standard toolbar’s Paste button 
and selecting Transpose.A 	 Excel creates a border to set off the array you specify in a TRANSPOSE 

function. 
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Fine-tune security on your workstations with 
Vista’s advanced firewall features

Administrators typically deploy firewalls at the network perimeter. The purpose of these “edge” firewalls 
is to protect the network at large from unauthorized or unauthenticated public access. Unfortunately, 
these firewalls provide little (if any) protection for individual workstations. After all, a bold attack against 
a workstation may not originate outside your network at all, but rather from a “trusted” source within the 
organization itself. In today’s computing environments, enabling a firewall on a workstation is part and parcel 
of a multilayered approach to security, especially when the workstation in question is a mobile unit. In this 
article, we’ll examine the protective capabilities that Vista’s advanced firewall provides.

Reset Windows Firewall
If your users have been experimenting 
with Windows Firewall and are having 
problems, it’s often easier to simply reset 
it rather than trying to troubleshoot it. 
For the purpose of this article, we’ll also 
reset it prior to delving into the Windows 
Firewall With Advanced Security.

To reset the firewall:

1.		  Open the Security control panel.

2.		  Click on the Windows Firewall link.

3.		  In the Windows Firewall window, 
click on the Change Settings link.

4.		  On the Advanced tab of the 
Windows Firewall Settings window 
shown in Figure A, click the 
Restore Defaults button.

5.		  Click the OK or Apply button, and 
then close any open windows.

Manage Windows Firewall 
With Advanced Security
There are several different ways 
to manage Windows Firewall With 
Advanced Security, including the 
following:

•		  Group policy.

•		  A pre-configured Microsoft 
Management Console (MMC).

•		  An MMC snap-in.

•		  Command line, using the netsh 
advfirewall context.

For the purpose of this article, we’ll work 
with the MMC shown in Figure B.

To manage Windows Firewall With 
Advanced Security:

1.		  Open the System And Maintenance 
control panel.

Related Courses
•	  	 5115 Installing and Configuring the Windows Vista™ 

Operating System

•	  	 5117 Installing, Configuring, Troubleshooting, and 
Maintaining Windows Vista®

I n f o r m a t i o n  S y s t e m s  P r o t e c t i o n

2.		  Click on the Administrative Tools 
link.

3.		  Double-click on the 
Windows Firewall With 
Advanced Security 
shortcut.

Configure Firewall 
Properties
Before creating connection 
rules, you should examine 
the properties of each 
default firewall profile. The 
firewall profiles included 
with Vista are:

A	

You can easily reset 
Windows Firewall to its 

default settings.

http://www.newhorizons.com/content/CatalogSearch.aspx?Core_PK=20003138&ML=true
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3.		  As shown in Figure C, select the 
tab of the profile whose settings 
you want to modify.

Regardless of which profile you’re 
configuring, you can make the following 
changes:

•		  Turn the firewall on or off.

•		  For inbound connections, 
specify whether to block 
connections (other than those 
on the exceptions list), block all 
connections (including those 
on the exceptions list), or allow 
connections.

•		  For outbound connections, 
specify whether to block or allow 
connections.

In addition to configuring firewall 
profiles, you can specify methods for 
establishing secure communications. 
To do so, select the IPsec settings tab, 
and then configure the IPsec Defaults 
and IPsec Exceptions. As you can see, 
the IPsec Defaults allows several layers 
of configuration and gives you granular 
control over your communications.

Create connections rules
By default, Windows Firewall With 
Advanced Security blocks all incoming 
connections (unless they originated 
inside the firewall) and allows all 

outbound connections. You can change 
this behavior, however, by modifying 
inbound and outbound rules.

Figure D shows the default 
inbound rules; a similar list appears for 
outbound rules. Rules whose icons are 
dimmed are currently disabled; those 
whose icons appear normal are cur-
rently enabled. From the list of rules, 
you can perform the following com-
mon tasks:

•		  Right-click on a rule, and then 
choose Enable or Disable, as 
appropriate.

•		  Right-click on a rule, and then 
choose Delete to permanently 
discard it.

• Right-click on 
a rule, and then 
select Properties to 
configure advanced 
settings.

You can also 
create your own con-
nections rules for situ-
ations not addressed 
by the default rules. 
To do so, you launch 
the New Rule Wizard.

•		  Domain Profile. Applies to 
computers connected to a domain.

•		  Private Profile. Applies to 
computers connected to private 
network.

•		  Public Profile. Applies to computers 
connected to a public network.

To configure Firewall Properties:

1.		  In the Overview section of the 
MMC, identify the three default 
profiles and note which one is 
currently active.

2.		  At the bottom of the list of profiles, 
click on the Windows Firewall 
Properties link.

Using this MMC, you can configure Windows Firewall With Advanced Security.B 	
C 	
Each network profile 
has unique settings.
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To create a connection rule:

1.		  In the MMC console tree, first 
select either the Inbound Rules 
or the Outbound Rules node, as 
appropriate.

2.		  In the Actions pane, click on the 
New Rule link.

3.		  Select the option button 
corresponding to the type of rule 
you want to create.

4.		  Click Next, and then follow the 
wizard’s prompts.

Create security rules
While inbound and outbound rules 
define the types of traffic to allow or 
block, as well as its direction, security 
rules define methods for encrypting the 
communication. In short, security rules 
IPsec policies. By default, no security 
rules are defined.

To create a security rule:

1.		  In the MMC console tree, select the 
Connection Security Rules node.

2.		  In the Actions pane, click on the 
New Rule link.

3.		  Select the option button 
corresponding to the type of 
security rule you want to create.

4.		  Click Next, and then follow 
the wizard’s prompts; as with 
connection rules, the prompts 
vary based on your selection in the 
previous step.

Monitor your firewall
After you define connection and security 
rules, you must monitor the firewall’s 
operation. It’s far too easy to inadvertently 
allow unwanted traffic, or block otherwise 
permissible communications.

To monitor your firewall:

1.		  In the MMC console tree, select the 
Monitoring node.

2.		  In the Monitoring pane shown 
in Figure I, examine the Firewall 
State as well as the General and 
Logging Settings.

3.		  Click on the appropriate links to 
view the active firewall rules, the 
active connection security rules, 
and the security associations.

Several inbound rules already exist but only a few are enabled by default.D 	 Use the Monitoring pane to keep tabs on your firewall’s state.E 	
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Speed up your design time and place multiple 
files quickly with InDesign CS3

With every new software release, the improvements leave us wondering how we ever survived doing 
layout and design work in the early ‘90s! We had to fake drop shadows, had limited file-format support, 
and lacked the processing power to import high-resolution images (thus the need to use FPOs). For 
that matter, we didn’t even have InDesign! So, we feel a little lazy complaining about how inconvenient 
it used to be—before CS3—having to import every image into an InDesign layout separately. But lazy 
feelings aside, let’s take a look at this great new feature! 

Rev up your layout
To demonstrate this new feature, we’ll 
show you how we quickly placed the 
images into the flyer shown in Figure A. 
Before we can place multiple image files, 
we need to load them. (Images provided 
by PhotoSpin. Some images modified for 
educational purposes.)

Tip: For the purpose of this article, we’re 
placing graphics files, but you can also 
place multiple text files with this new 
feature.

To load multiple image files:

1.		  Launch InDesign CS3 and open 
your InDesign file ready for 
placement, as shown in Figure B.

2.		  Choose File > Place or press [Ctrl]D 
to display the Place dialog box.

3.		  Navigate to the cars folder, press 
[Shift], and click on all the files in 
the folder.

Tip: Pressing [Shift] allows you to select 
multiple contiguous f iles. To select 
multiple non-contiguous files, press 
[Ctrl].

To place multiple image files:

1.		  Hover the loaded cursor over the 
top-left graphic frame. Notice the 
loaded cursor displays an image 
thumbnail and the number 9, as 
shown in Figure C. 

2.		  Click the cursor on the top-left 
graphics frame to place the image. 
Notice the loaded cursor now 
displays the number 8, indicating 
that there are only 8 images 
loaded. 

Related Courses
•		  InDesign CS3 - Level 1

•		  InDesign CS3 - Level 2

D e s i g n ,  M e d i a  &  G r a p h i c s

Vintage Car Show

At The Dome

April 25, 2008 • Noon to 6pm

You can place all of these 
images at once instead 
of wasting time to place 
them separately.

A 	
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3.		  Continue clicking in the remaining 
graphics frames to place the rest of 
the images.

Tip: When the cursor is loaded with 
multiple images, a number displays 
indicating how many images are loaded 
and a thumbnail preview displays 
indicating which image will be placed 
next. To cycle through the thumbnail 
previews and select a different image, 
simply press the arrow keys.

Resize the images quickly
Now that we’ve placed the images, we 
need to resize them. We want our images 
to fill the frames, but we’d like to preview 
more of the cars. We’ll resize all of the 
images at the same time with the Fitting 
command.

To resize the images quickly:

1.		  Press [Ctrl]A to select all the 
graphics frames.

2.		  Choose Object > Fitting > Fill 
Frame Proportionally.

3.		  Select the Direct Selection tool 
from the Tools panel and click 
inside each photo, and nudge it 
with the left and right arrow keys 
to center position the image how 
you like it.

For results shown in Figure A, we 
applied a drop shadow to the images 
and added text.

Graphic & Design eTips to Enhance 
Your Work
If you are an expert at what you do, then you 
want to sign up for FREE New Horizons Graphics & 
Digital Designer eTips. Each week you will receive 
expert advice from our experienced editors that 
will improve your productivity and enhance your 
work. Learn more about the applications you use 
everyday, including: Adobe Illustrator, Adobe 
InDesign, Adobe Pagemaker, Adobe Photoshop, 
Digital Photography and QuarkXPress. Imagine 
the possibilities with the skills you’ll gain!  

B 	
This InDesign file is 
ready for you to place 
your images.

C 	
When you load several 
images, InDesign 
gives you a preview of 
what image is on deck 
before you place it.

http://www.newhorizonsetips.com/
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Quick Tips

Eradicate unwanted imported hyperlink 
boxes (InDesign CS/CS2/CS3)
An annoying occurrence that often confuses new InDesign users is imported 
text displaying with a box around it. Intuitively, you should be able to select and 
delete the box—but you can’t. There is, however, an easy way to remove it. 
Here’s how:

Choose > Window > Interactive > Hyperlinks to display the Hyperlinks 
panel. You’ll see a hyperlink listed in the panel for each boxed text segment in 
your InDesign document. Click on a hyperlink and drag it to the Trash icon at 
the base of the Hyperlinks panel to remove it. Click Yes in the resulting warning 
box asking if you’re sure you want to remove it. Repeat this step for each 
hyperlink present. 

You may also notice a new hyperlink style in the Character Style panel. 
To delete that, simply click on the character style and drag it to the Trash icon 
located at the base of the Character Style panel. 
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